
Consult this page when configuring the Agiloft Contract Assistant for . Word

This process tells Agiloft which tables and fields in your KB should link to the fields on the app interface. This step 
must be completed before .installing

Check to ensure your KB aligns with the recommendations in this section before continuing on to the configuration 
section.

Before you configure the app, you should have multiple fields and tables in your KB. If you've used the standard 
CLM Template or CLM AI Template, these tables are all available by default.

You should have the following tables in your KB. 

Contracts: This table holds Contract records. The app can add new Microsoft Word documents to the 

Contracts Table as new records.

Attachments: This table holds Attachment records, which are the file version of the contract document being 

analyzed in Word. The app adds Microsoft Word document files to the Attachments table as new records. If 

you have AI enabled, the Attachments table is the ideal table for holding machine learning action buttons, 

which exist by default in the CLM AI Template.

Clause Library: This table holds Clause records, which represent existing, vetted clauses that you can  
compare against the clauses found in the contract document in Microsoft Word. You can also insert these 
clauses directly into the contract document using the Insert Library Clause function, or add clauses to the 
Clause Library table from a trusted contract document.

Contract Clauses: This table holds Contract Clause records, which are new clauses identified in the Word 

document. The app can add  clauses as new records to the Contract Clauses table. You can tagged

distinguish which Contract Clause records relate to which Contract record by the ID field.

Configuring the Agiloft Contract Assistant 
for Word

Prerequisites

Tables

If your KB was created prior to November 13, 2020, reach out to your  Agiloft repre  for sentative
assistance in configuring your Clause Library to work with the app. There are a few global variables 
that may need to be added to make this possible.
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: Clause Types This table holds Clause Type records, which represent the types of clauses that your 

organization wants to identify in contract documents, such as Termination or Insurance. The records in this 

table are used by AI to identify clauses in the contract document, but can also be manually assigned by a 

user if AI is not enabled in their system.

AI Clause Types: You only need this table if your system uses AI. This table holds AI Clause Type records, 

which represent the clause types that are used to train AI models to identify clauses in contract documents. 

These records are associated with Clause Type records in the Clause Types table. Holding these records in 

separate tables allows for more system flexibility. This table is only necessary if you have AI enabled in your 

system. Simply adding a record to this table will not , as this requires custom model train AI to recognize them

training.

 This table holds Contract Type records, which represent the types of contract documents Contract Types:

that are used in your system, such as Master Services Agreement or Non-Disclosure Agreement. You can 

integrate this table to manually  you've uploaded with Word. identify the type of document If you have AI 

enabled, you can use this information to  kind of clauses and key terms to look for in train the AI model what

the contract document. Your Contract Types should also each include a list of required Clause Types, so the 

Word app can let the user know when a contract doesn't include all the required clauses.

Key Terms:  This table holds Key Term records, which represent the types of key terms that are identified in 

contract documents, such as Contract Title or Contract Start Date. The records in this table are used by the 

AI to identify key terms in the contract document, but can also be manually assigned by a user if AI is not 

enabled in their system. There is no key term l  table because key terms are stored in the fields of the ibrary

Contract record, unlike clauses and the Clause Library and Contract Clause tables.  new Key Term Adding

records to this table, and then associating them with a corresponding field in the Contracts table, allows the 

app to use those key terms as labels. However, these must always be tagged manually; adding a new Key 

Term record to this table doesn't allow the AI model to recognize or extract that key term, as this requires 

 For more information on the Key Terms table, view the Key Terms Table section custom model training.

below.

Permissions

To use the app, users must have the following permissions set:

Users must be granted access to REST services. Click the gear icon and go toSetup   System > Manage 

 . In Groups Allowed for REST, select all the groups that need to work with the app. To select Web Services

multiple groups, hold the Ctrl key while making selections.

Users must have  permissions, at the least, for all of the tables included in the configuration wizard in Create

order to use the app properly. For example, you need permission to create Clause Library records in Agiloft if 

you want to be able to insert clauses from the Clause Library into a document.
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To configure the app:

In your KB, navigate to the  gear in the top-right corner and go to Setup Integrations.

 Under Agiloft Contract Concept Mapping, click . Doing this for the first time in a KB automatically Configure
 Key Terms table, if it doesn't already exist. This brings you to the General tab.adds the

Follow these steps to fill out the fields in the General tab.

Under the  section, choose the table that holds records for attached files like Attachment Table .docx or PDF

. This is likely the Attachments table.

Under , choose the field that  the actual Word document file uploaded from the app. Attached File Field holds

This drop-down list allows you to choose from all the File with Versioning fields from the table you selected in 

the Attachment Table section.

Under the  section, choose the table that holds company information in your KB.Companies Table

U , choose the field that holds the name of the company that you are doing business nder Company Name

with, also called the the counterparty. This should not be the name of your company.

Under the section, choose the table that holds records on individuals, such as employees or People Table 

external users.

Under , choose the field that holds the individual's name. Person's Full Name

Under , choose the field that holds the user's photo. This is an optional field, Requester's Profile Picture

and there are no issues that will arise if the field is left empty.

Under the  section, choose the table that holds records for different types of contracts. Contract Types Table

This field's value determines the drop-down list choices for the Contract Type fields.

Under , choose the field that holds the name of the contract .Contract Type type

Under , choose the field that holds the status of the contract type.Contract Type Status

Under the  section, choose the table that holds clauses after they have been Contract Clause Table

extracted.

Under the  section, you will see an entry for Contract table, which you can edit to Table Configurations
complete the configuration. Some of the fields in Contract may be mapped already. 

Configuring the Agiloft Contract Assistant

You may also see an option to Upgrade. For information about upgrading, visit Upgrading the Agiloft 

.Contract Assistant for Word

General

https://wiki.agiloft.com/display/HELP/Upgrading+the+Agiloft+Contract+Assistant+for+Word
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Contracts Window

Under , select where you'd like the app to create new contracts.  Contract Tables

Under , choose the field that you'd like to use to designate Contract Types. If this field doesn't  Contract Type

show any options in the drop-down list, ensure that the Contract Type Table section in step 22 has a value.   

Under , choose the field that holds the title of the contract. Contract Title

Under , choose the field that holds a description of the contract. Contract Description

Under , choose the field that holds the contract status. Contract Status

Under , choose the field that holds the name of the company that you are doing business  Company Name

with, also called the the counterparty. This should not be the field that holds the name of your company.

Under , choose the field that holds the ID of the parent Contract record. Parent Contract ID

Under , choose the field that holds the record type. Record Type

Under , choose the field that holds the start date of the contract. Contract Start Date

Under , choose the field that holds the end date of the contract. Contract End Date

Under , choose the field that indicates who requested the contract. Contract Requester

Under , choose the field that indicates when the record was last updated. This coincides with  Date Updated

the Name of Latest Updater field.

Under , choose the field that indicates who the last user to edit the record was. This  Name of Latest Updater

coincides with the Date Updated field.

Under , choose the field that indicates the field that holds comments about contracts.  Contract Comments

This field is used  the Comment feature in the Word app, and is often omitted from the actual Contract by

table layout. 

Under , choose the field you'd like missing clause types to show up in. For this to Missing Clause Types

work, you need to  in the Required Clause Type field of a Contract Type record. If you don't link Clause Types

have this field, visit the  section below.Missing Clause Types

Under , choose the field that holds the hotlink to the Contract record. If you don't have a Link Link URL Field

URL field, you can continue to use the app as usual, you just won't be able to open Contract records in a 

flyout directly from the Word app.

Under , select the ID field that links the contract to an attachment.Contract ID

Under , choose the ID field that links Contract ID linking contract clause table to chosen contracts table

the contract to the contract clause table. This is usually the same as the selection in Contract ID.

The Table Configurations section is also where you can add support for multiple Contract tables. To 
configure an additional Contract table, click New and then continue to follow the steps below. Some 
of the fields may be mapped already. Note that the Word app is only recommended for tables that 
contain the fields requested by the setup wizard; if you configure the Word app for a table that does 
not have these fields, it might not function properly. Additionally, every table you configure must point 
to the same Attachment, Contract Type, and Contract Clause tables when you configure those 
relationships in steps 1, 8, and 11 above.



19.  

20.  

21.  

22.  

23.  

24.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

Under , select the field that holds the contract type for Contract Contract Clause Contract Type Field

Clause records.

Under , select the field that holds the start date associated with a contract Contract Clause Start Date Field

clause.

Under , select the field that holds the title of Contract Clauses records.Contract Clause Title Field

Under , select the field that holds the company name associated Contract Clause Company Name Field

with a contract clause.

Click Save.

If you plan on using AI, expand the tab in the AI Fields section. Otherwise, continue on to the  Clause Fields

.section

If you have enabled AI in your KB, follow these steps to fill out the fields in the AI Fields tab.

Set Enable AI Functionality to Yes. This adds many new options to the page, which are used to configure the 

app with Agiloft's AI capabilities. 

Under , choose the table that holds the AI  Table that holds the Document Classification action button

action button that allows you to predict Document Type. This is likely the Attachments table.

Under , choose the action button  Action Button field to use when requesting Document Classification

that allows you to predict Document Type. This drop-down list contains action buttons from the table selected 

under "Table where the Action Button field to use when requesting Document Classification can be found."

Under , choose the AI Document Classification Input field  File with Versioning field that holds the 

document you'd like to load into the app. This drop-down list contains File with Versioning fields from the 

table selected  "Table where the Action Button field to use when requesting Document Classification under

can be found." The file, or value, contained in the chosen File with Versioning field should be the same for 

every "Input" field in the Enable AI Functionality section. You have the option to select an input more than 

once, just in case your machine learning action buttons are found in different tables.

Under , choose the Text field that you'd like the AI model to output  AI Document Classification Output field

information to. This drop-down list contains Text and Short Text fields from the table selected under "Table 

where the Action Button field to use when requesting Document Classification can be found."

Under choose the table that holds the AI action  Table that holds the Clause extraction action button, 

button that allows you to extract clauses. This is likely the Attachments table.

Under , choose the action button that  Action Button field to use when requesting clause extraction

allows you to extract clauses. This drop-down list contains action buttons from the table selected under 

"Table where the Action Button field to use when requesting Clause Extraction can be found."

AI Fields
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Under , choose the File with Versioning field that holds the document you'd AI Clause Extraction Input field

like to load into the app. This drop-down list contains File with Versioning fields from the table selected under 

"Table where the Action Button field to use when requesting Clause Extraction can be found."

Under , choose the Text field that you'd like the AI model to output AI Clause Extraction Output field

extracted clauses to. This drop-down list contains Text and Short Text fields from the table selected under 

"Table where the Action Button field to use when requesting Clause Extraction can be found."

Under , choose the table that holds the AI action Table that holds the Key Terms extraction action button

button that allows you to extract key terms. This is likely the Attachments table.

Under , choose the action button that Action Button field to use when requesting Key Terms Extraction

allows you to extract key terms. This drop-down list contains action buttons from the table selected under 

"Table where the Action Button field to use when requesting Key Term Extraction can be found."

Under,  choose the Attached File field that holds the document you'd AI Key Terms Extraction Input field

like to load into the app. This drop-down list contains Attached File fields from the table selected under 

"Table where the Action Button field to use when requesting Key Terms Extraction can be found."

Under , choose the Text field that you'd like the AI model to output  AI Key Terms Extraction Output field

extracted key terms to. This drop-down list contains Text and Short Text fields from the table selected under 

"Table where the Action Button field to use when requesting Key Terms Extraction can be found."

Document Risk is not used at this time. Skip over this section and navigate to the Clause Fields .tab

Follow these steps to fill out the fields in the Clause Fields tab.

Under Clause Library Table, choose the table designed to hold vetted, pre-approved   that Clause records
are readily available to be used in company contracts. This table is commonly called the Clause Library 
table.
Under Clause Library Table Clause Title, choose the Text field that holds the title of the clause. This 
drop-down list contains Text and Short Text fields from the table selected under "Clause Library Table."
Under Clause Library Table Clause Description, c . This hoose the Text field that holds the clause itself
drop-down list contains Text and Short Text fields from the table selected under "Clause Library Table."
Under Clause Library Table Clause Risk, choose the Number field that holds the risk value associated 
with using this clause. This drop-down list contains Number fields from the table selected under "Clause 
Library Table."
Under Clause Library Table Clause Type ID, choose the field that holds the ID of the clause type. This 
drop-down list contains all Integer and Auto-Increment fields from the table selected under "Clause Library 
Table."
Under Library Clause Status, choose the field that holds the library clause's status, which is generally 
either Active or Inactive.
Under Display Risk on Library Clauses, select an option.
Under Date Library Clause Updated, choose the field that indicates when the clause was last updated.
Under Associated Print Templates, choose the field that holds the document templates associated with 
the clause.

Clause Fields
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Under Clause it's a Fallback For, choose the field that holds the clause's fallback clause.
Under Available for Contract Types, choose the field that indicates which contract types this clause can 
be added to.
Under Clause Fallback Status, choose the field that indicates whether the clause is Standard or Fallback.
Under Boilerplate Status, choose the field that indicates if the clause is a boilerplate clause or not.
Under Clause Guidance Field, choose the field that holds usage information about the clause.

Under Contract Clause Text, choose the Text field where the modified clause text should be stored. This 

drop-down list contains Text and Short Text fields from the table selected under "Contract Clause Table."

Under Contract Clause Type  , choose the Text field that holds the clause type. This drop-down list contains 

Text and Short Text fields from the table selected under "Contract Clause Table."

Under Contract Clause Library Clause ID  , choose the field that holds the ID of the clause. This drop-down 

list contains all Integer and Auto-Increment fields from the table selected under "Contract Clause Table."

Under Contract Clause Risk  , choose the Number field that holds the risk value associated with using this 

clause. This is typically the Clause Type Default Risk field. This drop-down list contains Number fields from 

the table selected under "Contract Clause Table."

Under Contract Clause table has "Deleted" state, select whether or not the Contract Clause record's list of 

Status choices includes Deleted. If Yes, when the user deletes a clause from the Word app, it won't be 

deleted outright in the KB, the Contract Clause record will just be set to a state of Deleted. This is 

recommended. If No, deleting the Contract Clause in the Word app deletes the Contract Clause record in the 

KB.

Under Most Similar Clause ID, choose the field that indicates clause ID.

Under Date Contract Clause Updated, choose the field that holds the date that the contract clause record 

was last updated.

Under section, c the Clause Type Table hoose the table designed to hold records for the clause types in 

your system. This table is commonly named the Clause Type table.

Under , cClause Type Table Title  hoose the Text field that holds the name of the clause type. The clause 

types found here should match the clause types available from the choice in "Clause Library Table Clause 

Type." The drop-down list contains Text and Short Text fields from the table selected under "Clause Type 

Table."

Under  , choose the field that holds the status of clause types.Clause Type Status

Click Next.

This tab allows you to configure which tables are used to build or edit document templates, formerly known as print 
templates, in the app. For additional information about Document Templates, visit Creating Document Templates 

.with the Word App

Document Template Fields
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Under Document Template Table, choose the table that holds document templates. This is likely either 

the Document Templates table or Print Templates table.

Under Document File, choose the field where the file of the document template should be uploaded after it 

is created.

Under Title, choose the field that holds the title of the document template.

Under Template Description, choose the field that holds a description for the document template.

Under Template Status, choose the field that holds the status of the document template.

Under Publication Level, choose the field indicating the publication level of the document template. This 

would be the field that determines if a document should be public, internal, etc.

Under Related to, choose the field that holds the types of records the document template is related to.

Under Available for Contract Type IDs, choose the field that holds the IDs of contract types that this 

document template can be used with.

Under Linked Contract Types, choose the field that indicates the contract types that this document 

template can be used with.

If you plan to install the Word app from the Office add-in store, click  and continue on to Finish Installing the 

. Otherwise, navigate to the Download Manifest tab.Agiloft Contract Assistant

If you are using a manifest file for installation, follow these steps to download a manifest file from the Download 
Manifest tab. Otherwise, continue on to .Installing the Agiloft Contract Assistant

Select the "appsource" option.

Click the Download Manifest file button. Be sure to save this file somewhere safe.

Click .Finish

Continue to .Installing the Agiloft Contract Assistant

Download Manifest

https://wiki.agiloft.com/display/HELP/Installing+the+Agiloft+Contract+Assistant+for+Word
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The Key terms table is  added to your KB when you click Deploy under Word add-in in automatically Setup > 
. The default records in the Key Terms table map to fields in the Contract table. These Contract table Integrations

fields all share the same logical name as key terms, and Agiloft maps them to each other using REST API calls. 
You can create a new Key Term in your system by following these steps:

Create a new field in the Contract table. Ensure that you add the new field to the Contract record layout.

Create a new record in the Key Terms table. The Field Name field of the Key Terms record should contain 

the same value as the Field Name field of the Contract field you'd like the Key Terms annotation to map to.

Open the app, and the new Key Terms label is available in the drop-down list after tagging a key term.

Label using the new key term.

Navigate to the Upload to Agiloft section, and click the Sync to Agiloft button.

Refresh the Contract record. The new key term field should now include the same value you labeled back in 

step 4.

To use this feature, you need to define required clause types for each Contract Type, so the system can recognize 
when one is missing. For example, this feature can warn you when a Non-Disclosure Agreement contract doesn't 
contain a Termination clause, if you configure that contract type to require such a clause. Then, you need to create 
a linked field where that missing Termination clause is listed, so that the system can display all the clause types that 
are missing.

To set up the fields for required clause types and missing clause types:

Go to the Contract Types table and click the Fields tab.

Click New and select Link to single field from other table. 

Under Select table, choose the Clause Type table from the drop-down list. Select the Include fields from 

subtables checkbox.

Go to the Mapping tab and select Yes, fast search.

Key Terms Table

The AI extraction models are only designed to work with the default Key Term records. Extracting additional 
Key Term records  a custom AI model.requires

Missing Clause Types
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Go to the Field tab and select the Clause Type field. Under the Field label column, rename the field to 

Required Clause Types or something similar.

Go to Setup [Contract Type] and click the Layout tab. Add the Required Clause Types field to the layout and 

click Finish.

Go to Setup [Contracts] and click the Fields tab.

Using Ctrl+F, search for the term " " without including Link to:selected fields from other table Contract Type

the quotation marks. Edit this field.

Go to the Fields tab and select the checkbox next to the Required Clause Types field you created earlier.

Go to the Display tab and click Finish. Back in the table wizard, the new field is now be visible in the list of 

fields.

At the top of the page, click New and select Link to single field from another table.

Under Select table, choose Contract Clause from the drop-down list.

Navigate to the Mapping tab and select Yes, fast search.

Navigate to the Field tab and select the Contract Clause Type field. Under the Field label column, rename 

the field to Included Clause Types or something similar.

Click Next until you are on the Options tab.

Select the "The values from the record(s) in which the" checkbox. Choose Deletable from the drop-down list.

In the "field matches the value in" field, choose Deletable again from the drop-down list.

Scroll down until you see "Restrict the Contract Clauses from which values may be imported?" and select the 

checkbox next to a saved search.

Click Create New Linked Field Search.

Add the Simple filter.

In the first drop-down, do not select anything.

In the second TEXT drop-down, choose Contract ID.

In the third "contains, ~=" drop-down, choose "equals, =".

In the fourth Value drop-down, choose Variable.

In the fifth blank drop-down, choose $contract.id.

Click Finish.

Go to the Display tab and click Finish.

At the top of the page, click New and select Link to single field from another table.

Under Select table, choose Clause Type from the drop-down list.
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Navigate to the Mapping tab and select Yes, fast search.

Navigate to the Field tab and select the Clause Type field. Under the Field label column, rename the field to 

Missing Clause Types or something similar.

Click Next until you are on the Options tab.

Select the "The values from the record(s) in which the" checkbox. Choose Deletable from the drop-down list.

In the "field matches the value in" field, choose Deletable again from the drop-down list.

Scroll down until you see "Restrict the Contract Clauses from which values may be imported?" and select the 

checkbox next to a saved search.

Click Create New Linked Field Search.

Add the Simple filter.

In the first drop-down, do not select anything.

In the second TEXT drop-down, choose Clause Type.

In the third "contains, ~=" drop-down, choose "is contained in, <<".

In the fourth Value drop-down, choose Variable.

In the fifth blank drop-down, choose $contract.required_clause.

Make sure the now checkbox is selected.

Add the Simple filter again.

On the new line, do not select anything from the first drop-down.

In the second TEXT drop-down, choose Clause Type.

In the third "contains, ~=" drop down, choose "is not contained in, !<<".

In the fourth Value drop-down, choose Variable.

In the fifth drop-down, choose $contract.included_clause.

Make sure the now checkbox is selected.

Click Finish.

Navigate to the Display tab and click Finish.

Navigate to the Layout tab and add the Missing Clause Types field to the layout.

Click Finish.

Now, you the Missing Clause Types field should be available in the Missing Clause Types drop-down list of the 
configuration wizard.
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